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Abstract

Although many excellent data plotting programs such
as Gnuplot exist, as do programs for data fitting
and parameter estimation, it is valuable to combine
these two capabilities in a single extensible program
framework. The Cartan program makes use of in-
teractive data-loading or data-synthesis, data-fitting
and data-presentation ideas and employs Java and
Swing software technologies to support many of the
x-y (CARTesian-ANalysis) data manipulation tech-
niques familiar to experimental scientists. A particu-
lar feature of the program is its inbuilt and interactive
use of first-order calculus methods to track the prop-
agation of data uncertainties alongside the indepen-
dent and dependent variables themselves. The pro-
gram was originally intended as a teaching aid but can
be used as a science productivity tool. A discussion of
the code design and architecture is given alongwith a
review of ideas on data formats, data parsing and the
management and parameter and model estimation is-
sues. Some ideas on how to extend such a framework
to handle project-specific data models and formats are
also presented.

Keywords: x-y data; model fitting; plotting; error
analysis; data uncertainties; interactive models.
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1 Introduction

Like many scientists I was taught how to plot exper-
imental data in first year university laboratory ses-
sions. In those days (early 1980s) we still used graph
paper, but home computers were starting to make
chunky character plotting of data possible — as under-
graduates we did not obtain access to the expensive
mainframe and pen plotters until later. Plotting some
measured property against an independent variable is
therefore ingrained in many of us as the single most
important act of experimental data analysis that it is
hard to understand why more effort has not gone into
software tools available to do this. One can plot charts
using Microsoft Excel — and contrary to apparent wide
spread practice it is possible to plot error bars with
that tool. Later as a postgraduate I was introduced
to Unix plot and variants such as xplot [1] and psplot.
In the usual Unix style of a simple tool that does one
specific thing very well, they read a plain text file or
files of data and make a perfectly acceptable x-y plot,
including error bars and a variety of symbols. You
had to write your own programs to do fitting, or to
generate model data, separately.

The Gnuplot program [2] is a pretty good replacement
for those tools and it does a degree of other model
generation too, but it seemed to me that fitting and
analysing experimental data ought to be more inter-
active and furthermore that modern software technol-
ogy and desktops ought to be quite capable of doing
a least squares fit in real time — at least for the size
of x-y data set that one can understand in one’s head.
Some other excellent tools such as Matlab [3] or Math-
ematica [4] provide wholistic problem solving environ-
ments that include data-plotting, although those tools
are not necessarily cheap and in fact do not do quite
the interactive sort of data manipulation that I find
useful for numerical simulation experiments. Other
tools like R [5] provide good statistical analysis mech-
anisms [6], but again, not quite in the interactive form
I tend to use.

The Cartan program was designed as a wholly inter-
active tool, that would allow the user to load around
a dozen or so x-y data sets from plain ordinary text
files, with or without error bar uncertainty data and
support all the usual transforms and fitting operations
that I was trained to do manually. I was particularly
motivated to do this as I moved a plastic ruler across
a printout for the umpteenth time to convince a col-
league some plotted data lay on a straight line. In ad-
dition, I was trying to analyse Binder cumulants from
phase transitions in Ising model [7] simulations and I
realised that my colleagues and I had already invested
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a huge amount of computer time generating the raw
data and that therefore it would really be worthwhile
investing a bit of effort into an interactive analysis tool
that might guide us where to look in further numerical
experiments.
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Figure 1: The Main Cartan viewing DisplayPanel and
ControlPanel showing a straight line fit to part of
some Binder Cumulant data loaded from three sep-
arate files.

Figure 1 shows three curves of the Binder cumulant
— each point has been calculated from a simulation
taking many days — and the point of interest for this
finite size scaling analysis is the intersection point (and
its uncertainty) between the three cumulant curves.
Cartan has built into it the reporting capability to do
least-squares fits and compute this intersection point.

Many experimental data sets have problem data
points in them. In older times these were often due to
incorrect human reading of instruments or just plain
writing data down wrongly. Even with modern nu-
merical simulations, sometimes a job crashes, a file
gets corrupted, and the automatic data collection you
thought was foolproof turns out not to be. At any
rate, there is still a degree of human judgement often
required to decide what data a points to include or re-
ject for subsequent more careful examination. An in-
credibly important aspect of data analysis is of course
to make ongoing judgements during an experiment of
where to look - what parameter space needs refin-
ing, what area requires more statistical investigation
with bigger system sizes or more independent mea-
surements to average over.

The Cartan Program is a rather personal tool devel-
oped for my own use but was also heavily used by
my graduate students in “playing around” with data
- particularly incomplete data as it comes out of sim-



ulation programs - to guide the experiments. It is
not intended for wide release, but I believe the ideas
documented here may be of use to other tool makers.

Cartan has model fitting capabilities and data selec-
tion and editing and generation facilities as well as
basic data analysis and visualisation tools built in. It
supports quite a lot of the ordinary operations an ex-
perimental scientist uses in trying to understand what
to make of data. Cartan does allow reasonable output
in the form of a nicely laid out and annotated plot with
output options including the better known graphics
image formats like PNG or PostScript. It is capable
of managing as many data sets as will fit on the screen
- typically up to a couple of dozen, and it can manage
individual data set sizes of up to around 10,000 data
points. It was not designed to handle larger sets than
these — and in practice larger sets would typically be
pre-processed or reduced down by some other analysis
program anyway.

Cartan can be used in combination with Gnuplot —
which can often do more complicated renderings and
annotations for a final presentation plot. Cartan’s
power is in its quick and easy interactive use and it
will likely be maintained and extended by me for con-
tinued use in this niche. The main purpose of this
present document is as an aide memoire to me but
also as a sort of design philosophy and user manual
for students using it or just doing quantitative analy-
sis of experimental data, particularly as generated by
simulations.

This article is structured as follows: Section 2 de-
scribes the design philosophy and need for the Car-
tan tool. In Section 3 a description of fitting and er-
ror combination formulae using first-order calculus are
given. A detailed presentation of the Cartan architec-
ture and its components is given in Section 4 with
some discussion of the implementation in Section 5
and overall conclusions and areas for further develop-
ment given in Section 6.

2 Data Plotting

Generally when I do a numerical experiment my sim-
ulation program spits out a series of measurements
which might be a time series or of some property av-
eraged over different systems sizes or with different
model parameters. At any rate I will usually be try-
ing to see how some dependent variable (y) varies with
a dependent control parameter (x) and hopefully I
will have some definite means of estimating the un-
certainty in y and possibly also an uncertainty in x. I
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might want to see my data visually and decide what
points look “clean” and which might indicate (from a
large uncertainty) that I need more measurements, or
to see where the gaps I need to fill in in my experi-
mental procedure are.

The Cartan design philosophy is to support this inter-
active comparison of data points and data sets and to
easily allow filtering by range and uncertainty size, as
well as to support a number of quick and easily ap-
plied transforms such as logarithms, exponentiation,
sign reversal and so forth.

Cartan: XY Cartesian Data Analysis, Revision: 3.21 @KAH 2006
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Figure 2: Screen-dump of the Display Window show-
ing three test data sets with error bars.

Figure 2 shows a typical display of the plotting area
as rendered by Cartan. Three data sets are plotted
with error bars in both x and y and straight line have
been automatically fitted using a least-squares fit. In-
dividual data points can be excluded or data can be
filtered by range in x, y, error-in-x or error-in-y and
the fit is instantaneously recalculated and redrawn.
It is thus possible to obtain immediate feedback as
to the importance or role of the data. The variation
and thus the uncertainty in the fitted parameters can
thus be judged much more effectively than just from
a computed statistic.

3 Model Fitting and Reduction

Oftentimes a model is used to reduce a set of data to
one or more fitted coefficients or parameters in a fitted



model. Although the simplest of these is a simple
linear fit of a straight line (lin-lin), there are two other
important cases - log-log and log-lin - that crop up a
lot in scaling analysis and other applications a lot.

3.1 Lin-Lin Plots

The most well known form of this is in a regression
or straight-line fit whereby x-y data are modelled as a
line of the form y = ag + a1x where the experimental
data may have uncertainty estimates in the y values,
or both the x and y values or in neither. The two
best known algorithms for fitting a straight line in-
volve finding the least square sum of departures from
the fitted line and the experimental data or finding the
least absolute value of the summed departures. In ei-
ther case any available uncertainties can be exploited
to inverse weight the data so that good data is treated
as more important than data with a large uncertainty.

While these algorithms are usually fairly robust and
will generally come up with a sensible fit for sensi-
ble input data it is still valuable to be able to per-
form a fit interactively and visually judge the rela-
tive importance of outliers or data points that may
be anomalous. Data anomalies can creep into experi-
mental measurements for all sorts of reasons including
incorrect transcription, human idiocy or faulty sensors
and other mechanical problems. In any case, support-
ing an interactive fit allows a human to make a sensi-
ble judgement whether the fit is justified and indeed
to what extent the fitted parameter can be trusted.

Supporting tools to temporarily adjust the data inclu-
sion filters and instantly see the response to the fitted
line and its parameters gives a very sound way of es-
timating uncertainties in the fitted parameters them-
selves. Interactive comparison of fits to different data
sets all viewed together can also give important visual
clues to interpreting a set of measurements.

3.2 Log-Log Plots

If we have a straight line fit to a log-log plot, we obtain:
logy = ap+ailogz (1)
= ag+ logx™ (2)

and taking the exp of both sides:

y = exp(ag + logz!) (3)
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which becomes:

y = exp(ap) x exp(logz™) (4)
= exp(ag) x ™ (5)

So that the slope of the straight line fit is the exponent
of a power law relationship and the exp function of the
intercept gives the scaling multiplier.

This works for logs of other bases too, so for example
a log, fit would give the multiplier as 2?0, or a logy,
fit would have a multiplier of 10%°.

Usually a fit will yield a standard deviation or other
uncertainty measure in the coefficients dag, da;. In a
log-log plot we end up using and quoting the exponent
a; directly. However for the multiplier, we can use the
relationship:

d;;lo exp(ag) = exp(ag) (6)

which we can use for a first-order approximation for
the uncertainty in the multiplier as

0 = exp(ag)dag (7)

This is obviously sensitive to errors in ag which be-
come magnified for ag > 0.

3.3 Log-Lin Plots

If we have a straight line fit to a log-lin plot, we obtain:

logy = ap + a1z (8)
and taking the exp of both sides:
y = exp(ao) exp(a1z) (9)

Similarly if we have a straight line fit to a lin-log plot,
we obtain:

y = ag+ailogzx (10)
= ag+loga™ (11)

or:
exp(y) = exp(ag)x™ (12)



3.4 General Linear Model Fits and
Non-Linear Fits

A full discussion of fitting more general linear model
and the even more general case of fitting non-linear
models is beyond the scope of this present note. Some
prototype implementations have been incorporated
into Cartan, and the algorithms are discussed in detail
in [8]

4 Cartan Implementation

The Cartan display is managed in both data units and
pixel units. When the mouse is pressed its location in
data units is shown in black. If a data point or control
feature is highlighted by the press, then the distance
(in data units) from the mouse to that feature is shown
in red. The data set to which the data point belongs is
also shown. Selecting a point makes its set the selected
data set as displayed in the Data Manager.

The program manages a list of data sets. Each set
can contain an arbitrary list of x-y-dy data. Each
set is numbered. The zero’th set is the ”scratch” set.
Opened xy-files go into set numbers 1,2,... and so
forth.

4.1 Data Manager Window

YA YA
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Figure 3: Data manager window for Binder cumulant
example.

Figure 3 shows the data Manager window for the
Binder cumulant example. The three data sets have

CSTN-062

been loaded from file and show up as a coloured line
record.

The Data Manager Window allows data sets to be
made active or inactive by tick-boxes. It also reports
their set number and name. The ”Selected data Set,”
and there can be at most one, is shown by small round
radio buttons, and also the toolbar background colour.
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Figure 4: Screen-dump of the Data Manager Window
showing a single scratch data set - generatable inter-
nally for test purposes - as well as the data transform
tools widgets and selection filters.

Figure 4 shows how the data manager can also be
used to generate simple test data sets, and transform
them, save them or combine them with other loaded
data sets.

The plotting symbols used are chosen by default from
the data set index. This can be customised by clicking
on the plot symbol icon shown next to the data set in
the Data Manger dialog. A blank symbol is also avail-
able. The size of (all) plot symbols can be changed in
the render dialog.

Tools available on the DataManager include:

e Delete the selected dataset, removing it entirely
from the data manager.

e Purge the selected dataset, removing any data
points that are outwith the present data filter

e Sort the data set in ascending x point order, de-
scending y order - mostly useful to resolve appear-
ance problems when drawing lines joining points
or when making a bar-chart.

e Save the scratch set to a ”proper data set” at the
end of the list.

e Copy the selected data set to scratch

e Append a copy of the selected data set to
scratch.



Make a copy of the current synthesised data
set in scratch

Create a unit test set (in scratch) of the line y =
2 + 0.1 uniform random noise, on z : [—10, 10]

Create a Gaussian distributed test data set
in scratch

Normalise the selected data set so that all its
data are on x:[0,1]; y:[0,1]

Central-Normalise the selected data set so that
all its data are on z : [—1,1];y : [-1,1]

log-log, log x and log-y data transforms - these
all work on the selected data set (natural logs,
base-e)

Rescale the selected data set, transforming x to
a + bxr and y to ¢ + dy.

Transpose the data set so that x becomes y and
vice versa. Likewise the x and y errors

Histogram the data sets x values to make a his-
togram in scratch

Average points to reduce the size of the data
set. This does a simple averaging (in place) of a
specified number of points in both the x and y
values.

FFT - perform a real Fast Fourier transform of
the selected data set.

y-Normalisation so that the sum of all y values
are unity

y-Max set equal to unity by scaling all values in
the set

y-Abs - sets the y values to their absolute values
y-Minus reverses the sign of the y values

scratch -= and scratch += subtract from or add
to the scratch set - assuming the scratch and se-
lected sets have the same order and values of ab-
scissae.

xIndex sets the x values of the set to their point
ordinal index.

Errs - offers a linear way to construct errors in
the data set as a proportion of the x or y values
and also with a fixed amount.
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4.2 Mouse & Keyboard Controls

The mouse controls are still under development - some
choices still to be ratified but at present:

e a press selects a nearby point

o a ALT (after a press is started) followed by a
drag changes the x value of the point

e a SHIFT (after a press is started) followed by a
drag changes the y value of the point

e a CONTROL (after a press is started) followed
by a drag changes the y-error value of the point

e an 'x’ during a press deletes the selected point.
e an ’a’ during a press annotates the selected point.

e an ’'h’ during a press hides (de activates) the se-
lected point.

e an '¢’ during a press copies the selected point to
scratch (unless it is already part of scratch.)

e an 't’ during a press transfers the selected point
to scratch (unless it is already in scratch.)

e a SHIFT-click adds a point at an arbitrary loca-
tion. It is added to the selected data set.

(After-press issues seem to be related to Macs with-
out a 3 button mouse, where the CTRL keys etc mean
something special in terms of the virtual mouse. Plug
in a 3 button mouse and all is well.)

There are also associated Keyboard Controls that
go with mouse selection of points. Selecting a point
by holding down the mouse button near to it allows
you to change the x and y values using the arrow keys
(left, right, down, up) in the obvious manner.

4.3 Data Models

A linear-regression fit (y = a + bx) can be done dy-
namically as the data are viewed/edited. The result-
ing fitted line is drawn in red and will be especially
thick to indicate a poor data fit. Results of the fit
can also be logged to the ongoing textual log. The log
can be viewed in the log Window and can be saved
to file. Moments and elementary statistics on the y-
values only can also be logged to the log. The fit can
be a least squares fit, or a ”least-abs” or ”"robust” fit.
Least-squares fits can include the use of y-errors as
(inverse) weights for the points, or not. Fit choices
are controlled from the Model Manager.



4.4 Data File Formats

Data files are assumed to be of the multi-column forms
(x-y-dx-dy; x-y-dy; x-y; x):

# a comment

1.0 2.0 0.0001 0.01 # a point label
2.0 4.0 0.0001 o0.01
3.0 6.0 0.0001 o0.01 # another label
or

# a comment

1.0 2.0 0.0001 0.01
2.0 4.0 0.0001 oO.01
3.0 6.0 0.0001 o0.01
or

# a comment

1.0 2.0 0.001

2.0 4.0 0.001

3.0 6.0 0.01

or

# a comment

1.0 2.0

2.0 4.0

3.0 6.0

or

# a comment

1.0

2.0

3.0

in this last case, the data are treated as y-values, and
corresponding x values are made from the index.

In the case of files with more than 4 columns, a modal
dialog inquires which columns are to be treated as x,
y, dy etc. The 4 column case indicates the presence of
dx error values (in the abscissae) as well as dy errors.
The canonical order is therefore x-y-dx-dy.

4.5 File Menus
The File menu offers choices to:

e open a new data file - multiple file selection is
supported
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e save the selected data set to file

e import imports xy data from a multi column for-
mat

e export submenu offers options to extract a single
field eg x, or y or dx or dy as well as exporting
the whole (selected) data set as comma separated
or tab separated formats.

e save and reload preferences information (stored
as plists on OS X)

e import / export XML versions of your prefer-
ence information

e print the current data viewer

e export image submenu offers choices including
ppm which saves the current view as a PPM im-
age file

e save the text log

e exit the program

The Edit Menu is still under design and at present
just supports deletion of all data sets (except the
scratch set). A recent addition is the capability to
restore all individually deactivated data points.

The View Menu is currently empty.

The Window Menu is still under design but currently
allows toggling visibility of the: Help Window, the
Data Manager window, the Log Window, the Model
Window and the Render Manager Window.

The Help Menu offers viewing of this help information
in a separate Help window.

4.6 XY Viewing Controls

A number of switch setting allow adjustment of the
plots appearance. These include the following, which
can be saved as preferences:

e Draw Axes to draw axes lines with numerical
graduation scales and tick marks

e Axes-Box to draw an enclosing box around the
plot area

e Central Axes to use axes centred on the
data origin (0,0) rather that at left(y-axis) and
bottom (x-axis)

e Draw Grid to draw a grid or mesh over the plot
area with grid-lines at the major tick marks



Frame to draw an enclosing frame or box around
the entire page

In-Ticks to use ticks that go up from the x-axis
and right from the y-axis instead of the defaults
- down and left respectively.

Draw Fit to automatically draw fitted lines ac-
cording to the present data model

X-Errorbars to show x-error bars for data point
y-€rrors

Y-Errorbars to show y-error bars for data point
X-€ITOr'S

Scale-All to automatically adjust the plot scale
range for all data (even for de-selected data sets)

Lines to draw lines connecting points in the order
in which they appear in their respective data sets

Points to draw each data point

Symbols to draw symbols rather than just dots,
if we draw the data points

Titles to draw the x-axis label, the y-axis label
and a title for the plot

Labels to draw any textual point labels found in
the file (following a # after each data point in the
file)

X-Filter to activate the x-data filter, so only
data points between the low and high values re-
main and are used in the currently selected model
fit - the limits are drawn as vertical lines

Y-Filter to activate the y-data filter, so only
data points between the low and high values re-
main and are used in the currently selected model
fit - the limits are drawn as horizontal lines

Y-Err-Filter to activate the dy-data y-errors
data filter, so only data points between the low
and high values remain and are used in the cur-
rently selected model fit - the limits are drawn as
an error bar symbol to the left of the plot area. It
can be clicked and dragged to change this limit.

X-Err-Filter is not yet implemented, but is in-
tended to be similar to the Y-Err-Filter.

Synthetic to draw a representation of the syn-
thesised data set

Barchart gives the option to draw a barchart
plot format
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The control area offers various (some experimental)
controls to change the plot area appearance. Most
are passive and are read by the display area when it
re-renders the plot. Some are active tools that change
the underlying data model. One such is the button
to reset the filters. There is also the capability to
constrain the axes min/max values or to set them to
specific defaults such as +1.

4.7 Display Control Pane

Figure 5 shows the main display and associated dis-
play controls. Three data sets are being selectively
fitted in x and straight lines are being fitted to the
filtered data.

The control area offers various (some experimental)
controls to change the plot area appearance. Most
are passive and are read by the display area when it
re-renders the plot. The plot area is computed auto-
matically with (by default) a pad area of 1 tick unit
at both min and max x and y. The pad area can be
explicitly set and constrained. Likewise the number
of tick units for each axis is computed automatically
but can be explicitly set and constrained. The actual
max and min values for x and y are also estimated
from the data set(s) but the inclusive choice can be
over ridden and constrained.

The Constrained Controls generally have a small
square checkbox to their immediate right. Checking
it fixes the value to what is in the box - although the
user can still edit it, the program will not try to recal-
culate it. Some controls such as the tick-pad spinners
have a small round button accompanying them that
resets their value to the default.

Some buttons are active tools that change the under-
lying data model. One such is the button to reset the
filters. There is also the capability to constrain the
axes min/max values or to set them to specific de-
faults such as +/- 1. Unit Box and Central Box set
the plot minima and maxima to specific values. Zero
Pad removes any padding that was automatically cal-
culated to keep the data points strictly inside the plot
area.

Combo boxes offer some other choices. The axes tick
numbers can be formatted in various ”printf” format
styles, the point labels can be shown at various rela-
tive positions to the data points, and a caption can
be generated as a key for explaining the symbols of
multiple data files/sets.
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Figure 5: Screen-dump of the Main Display Window with three data sets shown being fitted by straight lines and
with the x data filters activated.The display appearance controls and widgets are in a pane to the right.

4.8 Table View

The Table view provides a simple spreadsheet style
view of the individual point data in the selected data
set. Each point is shown with its index in the set, its
X, y, dx and dy values, an annotation string label if
any is present, and its activation status. The table
controls offer selection of floating point formats and
font.

Figure 6 shows the table view for the Binder cumulant
data set example. Individual points can be labelled or
de-activated directly by editing the table view.

4.9 Render Window

Some rendering controls such as those determining
the font size, border length, stroke thickness and
symbol size have been relocated to the Render Win-

dow. These parameters are common to all viewers
and so are not appropriate for the Control pane that
is matched with the XY display. Figure 7 shows the
rendering controls available in the render window.

4.10 Log Window

The textual log is maintained in a separate window.
It can be viewed and edited and saved to file. Its
toolbars also allow generation of fit information and
statistics on the data sets. Other information can be
logged from any part of the program.

Figure 8 shows the log window as it might appear
during analysis of the Binder cumulant data sets.

Figure 9 shows an alternative screen-dump of the log
manager window.
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for Binder cumulant example.
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Figure 7: Render manager Window showing some sec-
ondary sliders and controls to adjust the visual ap-
pearance of the plotting window - primary for use
when printing or saving as an image for subsequent
inclusion in a document.

4.11 Synthesis Window

The Synthesis window shows controls for adjusting
parameters for synthetic data models such as poly-
nomials or sin/cos or Fourier spectrums. Sliders allow
parameters to be adjusted in real time. The synthetic
data set can be viewed in the display area, and can be
copied to the scratch set and used as a normal data
set.

Figure 10 shows a screen-dump of the synthesis con-
trol window with slider controls for generating (in this
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Figure 8: Log window for Binder cumulant example.

case) synthetic polynomial data.

Figure 11 shows a polynomial being synthesised and
plotted alongside some experimental data loaded from
file. This gives a powerful yet flexible way to hypoth-
esise a model for some data and obtain immediate
feedback whether it is at all reasonable compared with
experimental data.

When a synthetic model is initiated by pressing a
selection from the synthesis tool bar, the user is
prompted for a number of coefficients for some models
such as arbitrary polynomials or spectra. This infor-
mation is used to rebuild the synthesis panel with the
appropriate widget set.

The synthetic data set can be saved to the scratch data
set - which in turn can be promoted to a full proper
data set and/or saved to file. This is controlled from
the Data Manager Toolbar.

The Synthetic data set has its abscissae computed
once on model initiation. If the data window is
changed or filters changed it can become inconsistent.
Double clicking the Draw Synthetic checkbox in the
plot control area will re-initiate the abscissae.
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Figure 9: Screen-dump of typical output in the Log
Window, which the user can type into, or cut and
paste from or save to file.
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Figure 10: Synthesis Manager Window showing slider
controls for generating synthetic polynomial data.

4.12 Model Manager Window

The Model Manager allows various models to be fitted
to one or more data sets. The principle models avail-
able are: Linear Least-Squares fit of a Straight line
with no errors; with y-errors only and with both x-
and y-errors. Linear Least-Absolutes "robust” fit of
a Straight line with no errors used. Linear Singular-
Value-Decomposition fit of an arbitrary order poly-
nomial with y-errors used and required. Non-Linear
Levenberg-Marquard fit of an arbitrary number of
Gaussian Peaks with y-errors used and required.
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Figure 11: Synthesised data plotted alongside experi-
mental data.
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Figure 12: Screen-dump of the Model Manager Win-
dow showing controls for selecting a model to fit and
some verbatim text of the fitted coefficients and statis-
tics.

In addition a compound fit model for Binder Cumu-
lants computes the intercept of several straight line
fits to separate data sets.

Each model is chosen from the Model Manager Tool-
bar, and can be recomputed dynamically and dis-
played in the plotting DisplayPanel if its Draw Fit
checkbox is set. Otherwise a fit can be initiated as
a once off from the compute Fit tool in the LogMan-
ager window. In either case both are subservient to
what model choice is made in the Model Manager. In
the case of models such as an arbitrary Polynomial
or Gaussian Peaks, the Model Manager offers Con-
strained Text fields for entering constrained parame-
ter values. If constrained a coefficient will yield a zero



uncertainty. Otherwise uncertainties in each param-
eter are given from the computed covariance matrix
during the fit.

Model fits will generally present fitted coefficients with
their uncertainties as well as a Chi-Squared goodness
of fit metric and others such as regression coefficients
and probabilities as appropriate to the algorithms and
models involved. The fit information is displayed dy-
namically by the model manager, and can also be
logged by the log manager.

Figure 12 shows a screen-dump of the model manager
window with controls for selecting which model to fit,
and verbatim text of the fitted coefficients and statis-
tics. This information can also be requested in the log
window which can be saved to a text file.

While a fit is attempted for each active data set, only
the selected data set can have its fit parameters con-
strained. The straight line fits will attempt to use
error data if available. If the Robust Fit check box
is set in the Model Manager, then the least absolutes
(robust fit) algorithm is used, and it ignores all errors
in x and y.

Generally straight line fits and polynomials are easily
recomputed interactively and several data sets can be
dynamically fitted ”"each time the mouse moves” or
each time a data point is added. This appears to per-
form a adequately even for data sets of several thou-
sand data points. However the non-linear fit uses an
iterative matrix algorithm, and it is likely to be slow
to refit dynamically other than for relatively few and
relatively small data sets.

4.13 Help Window

The in built web browser window capability of Java
Swing was used to provide help information in the
form of an HTML file, that can be bundled with the
Cartan Jar file installation.

Figure 13 shows a screen-dump of the typical help file,
with hypertext links to sections within.

5 Discussion

Cartan was packaged up as a self-contained Java jar
file. While I tends to launch it from a command line
using a shell alias and giving the names of data files
as command line arguments, I have noticed my stu-
dents feel more comfortable launching it as an iconic
graphical program and using the mouse to select data
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Introduction

The Cartan Program is a derivative of the Graphael Program architecture. Cartan has model fitting
capabilities and data editing and generation facilities as well as basic data analysis and visualisation tools
{built in.

|The display is managed in both data units and pixel units. When the mouse is pressed its location in data
units is shown in black. If a data point or control feature is highlighted by the press, then the distance (in
data units) from the mouse to that feature is shown in red. The data set to which the data point belongs is
also shown. Selecting a point makes its set the selected data set as displayed in the Data Manager.

|

The proeram manages a list of data sets. Each set can contain an arbitrary list of x-v-dv d‘z_nn Each setis ¥ i

Figure 13: Help Window which allows appropriate
rendering of help information written as HTML in-
cluding internal cross-referencing hyperlinks.

files once it is launched. The jar file with shell alias
supports both models of operation rather well and it
is not particularly difficult to compile, and install new
releases of Cartan.

Testing of Cartan was not difficult in its conception
phase and early development phase when all its work-
ings were clear in my head. The program has now
grown to approximately 17,000 lines of Java. While I
have managed to successfully use a component struc-
ture that means upgrades to the tool set can be made
with relatively clean and clear file modifications, in
hindsight I wish I had planned for some sort of Unit
testing at an earlier stage of development.

The internal data structures have proved easy to ex-
periment with although for with the design more fixed,
they could be improved for speed and response-time
performance. I used linked lists to store data sets.
It would be faster to use plain ordinary arrays with
accompanying boolean arrays to specify whether data
points are active or not. On modern desktops and
JVMs, memory is unlikely to be a performance limi-
tation.

The general layout of the controls is somewhat esoteric
and would no doubt benefit from some HCI considera-
tions, although like any complex scientific or technical
tool, it is straightforward to operate when the user



has a feeling for its purpose and a good grasp of its
working vocabulary, and its internal model of opera-
tion but quite difficult to use if this is not the case.

6 Conclusions

Java is a good prototype technology for a complex vi-
sual program like Cartan, and I see no reason why
it is not also useful for developing production tools
too. The general interactive loop of having a graph-
ics thread recompute and re-render as one interacts is
very powerful. Java on a typical desktop is adequate
for this. In general as long as one does not try to ma-
nipulate more than around 20 data sets each of more
than 10,000 data points, then the Cartan data struc-
tures, design and interactive performance are entirely
adequate. Beyond this - which is probably outside
my normal likely interactive requirements as a human
being anyway, the program and its graphics thread
do clearly struggle and the interactivity effectiveness
corrodes.

Generally as a prototype this project has been well
worthwhile. A production prototype could be de-
signed and built based upon the Cartan ideas. Sur-
prisingly there are still no obvious alternative tools
available commercially or publicly, that would support
the sort of analysis customisation and experimenta-
tion that I require. In terms of rendering, for many
purposes Gnuplot does produce a better rendered pro-
duction plot picture for inclusion in documents, but it
is still time consuming to set these up, “post-thinking
process” as it were. Cartan produces acceptable plots
as one goes along without the need to stop and focus
on the presentation. Writing up as one goes along is
— I believe — still an absolutely vital part of science
productivity.

There are some areas for further development of Car-
tan or a tool like it. There are new data transforms
that could readily be incorporated into the Data Man-
ager. Additional models to fit such as positive coef-
ficient polynomials for big-oh analysis of performance
and timing data would be useful. A 3D surface plot
capability, that could work similarly to gnuplot’s splot
capability is attractive and would use x-y-z data is at-
tractive, but might be better written as a separate
tool.

Generally the Cartan program implementation has
proved very useful in a number of computational sci-
ence experiments [9] and has aided the Complex Sys-
tems and Simulations Group to produce a number of
publishable quality data plots and analyses.
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